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Produmex WMS Complete Installation Guide

Produmex WMS Installation Guide

1. Introduction

This document describes the Produmex Suite Installer tool, which allows for complete installation and
configuration of Produmex WMS with the following components:

Produmex Tools
Produmex License server
Produmex Mobile Client (Fat Client with scanner or touchscreen modes)
Produmex SB1 Notification Listener: This is a tool (service) to perform certain actions that are
triggered by adding, updating and deleting data in SAP Business One.
Produmex ScaleComm: This is a service that can be used to integrate with scales.

The document also applies to the installation of Produmex WMS on a Cloud Environment managed by
Cloud Control Center. If there is a specific step, it is indicated in the document.

Note: The Produmex WMS add-on is registered and installed like a regular SAP add-on, and it uses an
add-on loader to upload the files to the database.

 

2. Prerequisites

The prerequisites for the installation of Produmex WMS for SAP Business One are the following:

Windows Server 2008 (minimum)
Installation of MS SQL Server or SAP HANA
Installation of SAP Business One 9.2 Patch level 5 or later

Note: From version 18.3 Produmex WMS supports 9.2 Patch level 5 and later for SAP
Business One. (This SAP version introduced a new licensing model to which Produmex
WMS has been adjusted because of the Boyum IT licensing solutions.)

Installation of .NET 4.6.2 framework (on every machine running Produmex WMS)
Note: After installing the .NET 4.6.2, the computer must be restarted before any other
install or upgrade process.

Installation of SQL Native Client and SQL ODBC driver for the proper SQL Server version (on
every machine running Produmex WMS)

For MSSQL 2016 and later, use the following links: native client and ODBC driver
Installation of HANA Client for the proper HANA version (on every machine running Produmex
WMS)
Administrative rights
Windows remote desktop licenses for Mobile Client terminals

Notes:

Some of the prerequisites are available here.

https://www.microsoft.com/en-us/download/details.aspx?id=56041
https://docs.microsoft.com/en-us/sql/connect/odbc/download-odbc-driver-for-sql-server?view=sql-server-ver15
ftp://public:Avaya789@ftp.produmex.name/Install/Prerequisites


Last
update:
2021/10/21
11:23

implementation:wms:completeinstallguide https://wiki.produmex.name/doku.php?id=implementation:wms:completeinstallguide

https://wiki.produmex.name/ Printed on 2025/08/09 01:21

If you have any antivirus software installed, add the .exe of the Produmex Suite Installer as an
exception.

2.1. HANA database privileges

When using a HANA user other than SYSTEM, grant additional privileges to the user in addition to the
standard privileges recommended by SAP.

You can set the proper privileges by executing the following SQL queries. Make sure you replace the
user, the schemas and the password before executing the queries. In the examples below, the user is
DBUSER, the company schema is TEST_WMS and the Produmex schema is PMX_TEST_WMS.

Creating a user:

CREATE USER DBUSER PASSWORD B1UserPwd NO FORCE_FIRST_PASSWORD_CHANGE;

SAP recommendations:

ALTER USER DBUSER DISABLE PASSWORD LIFETIME;
GRANT AFLPM_CREATOR_ERASER_EXECUTE TO DBUSER WITH ADMIN OPTION;
GRANT CONTENT_ADMIN TO DBUSER;
GRANT SAP_INTERNAL_HANA_SUPPORT TO DBUSER;
GRANT CATALOG READ, CREATE SCHEMA, ROLE ADMIN, USER ADMIN TO DBUSER WITH
ADMIN OPTION;
GRANT EXPORT, IMPORT, INIFILE ADMIN, LOG ADMIN TO DBUSER;
GRANT CREATE ANY, SELECT ON SCHEMA SYSTEM TO DBUSER WITH GRANT OPTION;
GRANT SELECT, EXECUTE, DELETE ON SCHEMA _SYS_REPO TO DBUSER WITH GRANT
OPTION;
GRANT SELECT, INSERT, DELETE, UPDATE, EXECUTE, CREATE ANY, DROP ON SCHEMA
SBOCOMMON TO DBUSER WITH GRANT OPTION;
GRANT SELECT, INSERT, DELETE, UPDATE, EXECUTE ON SCHEMA COMMON TO DBUSER
WITH GRANT OPTION;

Additional privileges required for Produmex WMS:

GRANT SELECT, INSERT, DELETE, UPDATE, EXECUTE, CREATE ANY, DROP, ALTER,
INDEX, TRIGGER, REFERENCES ON SCHEMA TEST_WMS TO DBUSER WITH GRANT OPTION;
CREATE SCHEMA PMX_TEST_WMS; -- skip this line if the PMX schema already
exists
GRANT SELECT, INSERT, DELETE, UPDATE, EXECUTE, CREATE ANY, DROP, ALTER,
INDEX, TRIGGER, REFERENCES ON SCHEMA PMX_TEST_WMS TO DBUSER WITH GRANT
OPTION;

 

3. Performing a Fresh Installation

The following sections describe how to perform a fresh installation of Produmex WMS.
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3.1. Set up the Produmex Suite Installer

1. Download the correct version of the Produmex Installation Zip file to your computer from here.

32 bit: Produmex_WMS_x_x_ x_x.zip
64 bit: Produmex_WMS_x_x_ x_x.x64.zip

Note: It is not possible to mix the two versions in one environment. Make sure that you either use the
32 bit or the 64 bit version of the software per environment.

2. Extract the file to a directory (preferably with the same name as the version number, e.g.
{driveletter}:\Produmex_WMS_523).

Note: It is not recommended to extract the file within the {driveletter}:\Program Files directory as this
might cause interference with installed components later.

Recommended step: Keep this directory on a shared folder accessible from all servers. That way you
can use the same configuration when you install and upgrade multiple components on separate
systems (e.g.: an SAP server and a terminal server).

3. Locate the directory of the Produmex Suite Installer
(e.g. Produmex_WMS_XXX.x64\9.3\ProdumexSuiteInstaller) and execute the .exe. Make sure that you
have administrator privileges when executing this application.

4. After launching the .exe file, the End User Licence Agreement window opens. Produmex WMS can
only be installed if the License Agreement is accepted.

The system proceeds to the Produmex Suite Installer and you can start the configuration of the
General tab.

3.1.1. General tab

This section describes the initial setup of the Produmex Suite Installer.

This configuration can be saved and reused for upgrades and it can also be modified (see section 5.
Adding a New Database to an Existing Installation).

3.1.1.1. System and server related fields

1. Computer name
Displays the name of the server we are currently running the Produmex Suite Installer on. It is
recommended to start the installation on the SAP server.

2. SAP license server

http://www.produmex.name/PmxVersions.php?p=WMS
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Provide the domain name of the server where the SAP license service is installed. This name should
be exactly the same as the one configured in SLD and should include the port number of the SAP
license server. On MSSQL, the port number is typically 30000, on HANA the port number is typically
40000.

3. DB server address
Provide the domain name of the server where the database is installed.

On HANA environment the port number of the database server should also be included.

Single-Database: The default port number is 30015.
Multi-Database: The DATABASENAME parameter must be used: DBA@< >. The default port is
30013. Example:

4. DB server type
Select the type of the database management system installed on the server.

5. DB user name
Provide the database username that has database owner rights on the SBO company database(s).

If you install Produmex WMS on Cloud Environment managed by Cloud Control Center, make sure that
the necessary extra database authorizations are granted for the tenant’s database credentials.

6. DB password
Provide the database user password.

7. DB culture
Provide the database culture.

3.1.1.2. Database and company related fields
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1. Environment
Select Production or Test environment.

This field corresponds to the Target Environment selected on top of the Produmex SuiteInstaller. This
feature can be used to install two different versions of the Produmex Suite Installer on one server.
One version can be the test version, and the other version can be the production version.
This field informs the system about the database/company that will be part of the production
environment and about the database/company that will be used as a test database.

2. Alias
Provide the Alias for the “ConnectionString”. This is the name you will use during installation and
configuration.

Note: It is recommended to use the database name as your alias.

3. Company database
Provide the name of the company database.

4. SAP user name
Provide the SAP user name. Typically the manager user is used here.

If you install Produmex WMS on Cloud Environment managed by Cloud Control Center, provide the
SAP user name in the format of domain\Windows username.

5. SAP password
Provide the SAP user password.

If you install Produmex WMS on Cloud Environment managed by Cloud Control Center, provide the
Windows password of the user.

Note: Make sure that you fill in the Alias, the Company database, the SAP user name and the SAP
password fields, otherwise the system displays an error message when installing the Produmex
components.

Testing connection

There are two …test… buttons for each database/company.

The first button tests the SBO connection trough DI-API. Click the button to start the test and
once the test is done, click OK.
The second button tests the direct SQL connection trough SQL Native Client. Click the button to
start the test and once the test is done, click OK.

Click the Save button in the bottom right corner.

Note: When saving the configuration, the system creates a .config file that can be used later for
potential upgrades.
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3.1.2. Create a new tab per server

If you run the Produmex Suite Installer from a shared folder that is accessible from different servers, it
is recommended to create a new tab for each server. Typically, there are at least 2 servers.

SAP server with the Produmex Tools, Fat Client & License Service (and other optional services)
installed
Terminal server with the Produmex Fat Client installed

Note: The Produmex license server should be installed on the same server as the SAP license server in
MS SQL environment (not in HANA environment).

1. Add a new tab (for the SAP server in this example) by clicking on the + icon next to the General
tab.

2. Provide the name of the SAP server and click OK.

 

3.1.3. System assignment

On the new tab click Assign to this Computer and the name of the server appears on the
System Assignment field.

The Produmex Suite Installer is informed that this is the server you are currently working on. This is
saved and next time the tool will open on the correct tab, depending on the server you are opening it
on.

 
 

3.2. Install components

On the Produmex Suite Installer screen the Available Version column shows the Produmex WMS
version you are going to install. To start the installation, proceed as follows.

1. Check in the Has Custom Files checkbox on the bottom right corner if there are custom files to be
installed, such as customer specific workflow scripts.

If the checkbox is tagged, during the installation process you must locate the directory where the
custom files are unzipped to. (Example of directory name: Project_OEC_1_0_0_327.)

2. In the Required column select the necessary components to be installed on the server.
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Typically, an SAP server has the Produmex Tools, the License Server and the Fat Client installed. If the
Produmex SB1 Notification Listener or a Scalecomm service is needed, you can install them on the
SAP server.

Note: It is not possible to have more than one Produmex License Server and Scalecomm service
version installed on a server.

3. If Produmex SB1 Notification Listener needs to be installed, after selecting the checkbox in the
Required column, select the instance alias in the Instance Alias column.

4. Click Install All and the system installs all the components selected in the Required column.

5. On the Select Connection for Licensing screen select the appropriate connection for licensing from
the drop-down menu and click OK.

Note: In the drop-down menu you will see all your connections that you can use for licensing. If you
have multiple installation numbers, make sure that you select the connection from where the
appropriate installation number can be retrieved.

6. The Produmex Suite Installer displays your installation number. If the installation number is correct,
click OK.

Note: In case there is a change in your licensing in the future and you need to change the connection,
click the Update Licensing Data button of the Produmex Suite Installer, choose the appropriate
connection and restart the service without reinstalling it.

7. The installation of the selected components starts. When the installation is successfully finished,
click OK.

8. If you have checked the Has Custom Files option in step 1, you must locate the directory now. Click
OK on the Produmex Installer screen, locate the directory where the files can be found and click OK.

The installation of the components is finished. Continue with the section 3.3. Configure components.

Note: The Update Connection String button is used when you add a new database to an existing
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installation, for more information click here.

 

3.3. Configure components

This section describes the configuration of the Produmex Tools, the Produmex License Server and the
Produmex SB1 Notification Listener.

The configuration of each component can be started by clicking the Config button on the
corresponding line.

3.3.1. Configure the Produmex Tools

1. Click the Config button of the Produmex Tools.

2. Select an instance alias which will connect to the company database and click Run to start the
Produmex Database Upgrade tool.

3. If necessary, change the connection by using the Connection drop-down list on the top of the
screen. The drop-down list is filled with all the connection strings found in the configuration file of the
Produmex Database Upgrade tool.

4. The tool has three options, which are checked by default:

(1) Upgrade database
(2) Update localizations
(3) Update add-on files (Create User Defined Fields)

Note: When updating/inserting/deleting database in a slower environment the installation could take
too long. In some cases it lead to timeout error (41088). In order to solve this issue please follow the
process in this article:

Error 41088 during fresh installation: When updating/inserting/deleting a business object then a
transaction must be running

(1) Upgrade Database:
The tool upgrades your database to the required Produmex version.

Create User Defined Fields:
The tool creates the necessary User Defined Tables. If the checkbox is not selected, the
necessary UDFs need to be created manually in SBO.

https://support.boyum-it.com/hc/en-us/articles/360011936058-Error-41088-during-fresh-installation-When-updating-inserting-deleting-a-business-object-then-a-transaction-must-be-running?source=search&auth_token=eyJhbGciOiJIUzI1NiJ9.eyJhY2NvdW50X2lkIjo0MTE3NTAsInVzZXJfaWQiOjE5MDgyODQzOTIwMzMsInRpY2tldF9pZCI6MjE3MzkxLCJjaGFubmVsX2lkIjo2MywidHlwZSI6IlNFQVJDSCIsImV4cCI6MTcwOTIwMTQxOX0.sYl6fSARfpjsS1v6DQOuOPoauSj0O7jW-36xVx1uXjM
https://support.boyum-it.com/hc/en-us/articles/360011936058-Error-41088-during-fresh-installation-When-updating-inserting-deleting-a-business-object-then-a-transaction-must-be-running?source=search&auth_token=eyJhbGciOiJIUzI1NiJ9.eyJhY2NvdW50X2lkIjo0MTE3NTAsInVzZXJfaWQiOjE5MDgyODQzOTIwMzMsInRpY2tldF9pZCI6MjE3MzkxLCJjaGFubmVsX2lkIjo2MywidHlwZSI6IlNFQVJDSCIsImV4cCI6MTcwOTIwMTQxOX0.sYl6fSARfpjsS1v6DQOuOPoauSj0O7jW-36xVx1uXjM
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Integration with Produmex Manufacturing:
Select the checkbox if you want to use the integrated Produmex Manufacturing solution (see
section: Working with Produmex Manufacturing and Produmex WMS).
Force to re-install PMX_SP_TransactionNotification: The checkbox is relevant in case of
future version upgrades:

During a database upgrade, stored procedures are installed or updated as well, but the
PMX_SP_TransactionNotification stored procedure is only added in case of a fresh
installation or when upgrading from a version lower than 6.3. To update the
PMX_SP_TranscationNotification during a version upgrade, select the Force to re-install
PMX_SP_TransactionNotification checkbox.
Select the checkbox to add the stored procedure if it is missing.
If this stored procedure has been customized, these customizations will be lost in case of
a version upgrade.

(2) Update Localizations:
This step updates localizations. It updates any translations to the required Produmex WMS version.

(3) Update Add-on Files:
This step uploads the Produmex suite add-on files necessary to run Produmex WMS.

Note: Before clicking Start, backup the stored procedure. If for some reason the stored procedure
has to be re-installed, install it manually from the backup.

5. Click Start and the tool displays the process.

6. On the Add-on Uploader Form select all row(s) corresponding to the installation and click Upload or
if all the rows must be selected, click Select All and then click Upload.

When the upload is finished, click OK on the form and the screen is automatically closed.

7. When the upgrade process is finished, close the Produmex Database Upgrade and the Produmex
Tools screens by clicking x in the top-right corner.

https://wiki.produmex.name/doku.php?id=implementation:manufacturing:wms_integration
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3.3.2. Configure the Produmex License Server

From product version 18.4 the license module uses the Boyum IT portal and the old
license file cannot be used anymore. When upgrading from a version older than 18.4 to
version 18.4 or higher, make sure that you have a license on the Boyum IT Portal.

3.3.2.1. Running the Produmex License Configurator

1. On the Produmex Suite Installer screen click on the Config button of the Produmex License
Server. The Produmex License service uses port 9997 to communicate with the WMS add-on. Port
9997 should be open on the Firewall.

2. Click on the Run button on the form that opens to start the license configurator.

Note: In the future the Produmex License Configurator can also be started by running the
Produmex.Sbo.Logex.Licensing.Configurator.exe file. Make sure that the License Configurator is
started in Administrator mode. (Example of file location: C:\Program Files (x86)\Produmex\Produmex
License Server)

3.3.2.2. The license file – online and offline solutions

The License Configurator offers two different options of licensing, automatic and manual:

Automatic licensing is an online licensing option. With active Internet connection your license is
automatically downloaded from the Boyum IT portal.

Manual licensing is an alternative offline solution. If you have a problem with automatic
licensing, for example you do not have active internet connection, manual licensing makes it possible
to add your license data manually. In this case you can obtain the data from the offline license
generator of the Boyum IT Portal.

https://license.boyum-it.com/Account/Login?ReturnUrl=%2F
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It is also possible to switch between the two options later.

If you switch from automatic to manual licensing in the future, the current license remains in
the system until you add a new license file manually.
If you switch from manual to automatic licensing in the future, the current license remains in
the system until the new license file is downloaded from the portal. Once it is downloaded, the
system uses your online license instead of the previously added manual one.

The next sections describe the steps of the automatic and the manual licensing process in details.

3.3.2.2.1. Automatic licensing

When you open the License Configurator, the Automatic license type is checked by default and the
License Configurator tries to download the licensing data from the Boyum IT portal automatically.

If you have an active internet connection and the license can be downloaded, you will see the
following message:

1. Click OK.

2. Click Save Configuration, then click OK.

3. Click Restart Service, then click OK.

Note: If you lose internet connection in the future, the License Configurator will use the online license
it has downloaded from the Boyum Portal last time.

If you do not need manual licensing, continue with section 3.3.2.3 The License Configurator window.

3.3.2.2.2. Manual licensing

If you are not automatically connected to the license system or you have no active internet
connection, you will see the following error message:

1. Click OK and select the Manual option.

2. The License Configurator sends the automatic message that your offline license file cannot be
retrieved. Click OK.

3. Visit the offline license generator of Boyum IT Portal to get the license data.

4. On the Get Manual License screen proceed as follows:

https://license.boyum-it.com/licensekey
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Fill in the Installation Number field.1.
Select the Produmex WMS Professional – User license in the drop-down Product list.2.
Click Submit.3.

Note: For more information on the installation number click here.

The portal displays the license data as follows:

5. Copy all the data to a new document of a text editor and save it to your local drive as a txt file. This
will be your license file.

6. On the License Configurator screen click on the Choose new license file button and browse
for the license file.

7. The License Configuration informs you that your manual license file has been loaded. Click OK.

8. Click on the Save configuration button to save the configuration and then click OK.

9. Restart the service by clicking on the Restart Service button. You are informed that the license
server has started. Click OK.

3.3.2.3. The License Configurator window

In the Licenses section every license from the license file is listed.

License parameters:

Type: The type of the license.
Valid Till: The expiration date of the license.
Count: The number of licenses.
Use Assigned Name (Y/N): Defines whether a user must be assigned to the license or not. If the
‘UseAssignedName’ option is active for a license, you have to link user(s) to the license.

Under Assigned Names every company that is included in the configuration file of the license
manager is listed. (Produmex.Sbo.Logex.Licensing.Configurator.exe)

Connection name
Company

Licenses that are currently in use are listed on the ‘Active licenses’ tab.

License type: The license type.

https://support.boyum-it.com/hc/en-us/articles/226546427-How-to-get-a-manual-license
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Assigned name: The SBO user/ thin client that is using the license.
User name: The Windows user that is using the license.
User domain: The server/PC where the license is being used.
Process ID: The Process ID that is using the license.

3.3.2.4. License types

Click here and consult with the article on Produmex WMS licensing for more information.

1. Produmex WMS Professional license (Add-On)
It is required to run the add-on in SAP Business One. On the License Configurator screen this is called
AddOnUser.

Add-on licenses must be assigned to specific user(s). The number of assigned users is not limited.
Only assigned users are entitled to a Produmex License.

The number of the available licenses defines the number of users that can use the Produmex WMS
add-on concurrently. If there are more users than the number of licenses, the principle of “first come,
first served” is applied.

Each time a user starts the add-on, the system checks whether the user is an assigned user and
whether there is a free license that can be allocated to the user:

If the user is not an assigned user, no license is allocated to the user.
If the user is an assigned user and there is a free license, the system allocates it to the user.
If the user is an assigned user and there is no free license, no license is allocated to the user. In
this case the Produmex WMS add-on can be started, but when the user tries to open a function
that requires a license, an error message is displayed.

After the user logs out, the system deallocates the license from the user.

Note: One user can only be assigned once even if multiple databases contain the same user. If a
given user is logged in to one database, the user can only log in to another database if there is a free
license. If a user is logged in to two databases, the user uses two licenses.

2. Produmex WMS Terminal license (Device Client)
It is required to run flows on the Fat Client (a scanner or a touchscreen). On the License Configurator
screen this is called DeviceUser.

The terminal licenses are unassigned licenses. If the license must be assigned, it can be assigned to
every Fat Client defined in the Organizational Structure of the company. The number of assigned
clients is not limited.

Device clients have concurrent licensing, that is, licenses do not have to be assigned to a certain
client. Instead the system allows as many concurrent connections as the total number of available
licenses.

Each time logging in on a client, the system checks whether there is a free license slot that can be
allocated to the client.

https://support.boyum-it.com/hc/en-us/articles/360009856517-WMS-Licensing
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If there is a free license, the system allocates it to the client.
If there is no free license, an error message is displayed.

After the logout, the system deallocates the license from the client.

3. Produmex 3PL Module
It is required to use the 3PL invoicing functionality. On the License Configurator screen this is called
Mod_3PL.

This license is an unassigned license. There are 99999 licenses available and when the Mod_3PL
license is active, every add-on user has access to the 3PL invoicing functionality.

4. Produmex EDI Interface
It is required to use the additional functionality for EDI messages. On the License Configurator screen
this is called Mod_EDI.

This license is an unassigned license. There are 99999 licenses available and when the Mod_EDI
license is active, every add-on user has access to the EDI functionality.

3.3.2.5. License assignment

To assign users to licenses, proceed as follows.

1. Select the company on the top of the Assigned Names section.

2. Select the necessary license type from the Show available names for type drop-down menu. Under
Available every user available from the selected company is listed.

3. Select the name and click on the left arrow icon to assign it to the selected license type.
If different companies have different users, they all have to be configured on the same Produmex
license server. You must get the list of users for each connection string and assign them all together
into a single list of assigned users.

Note: The sequence of the assigned users has no impact on license allocation.

4. Click Save Configurations and close the License Configurator screens.

The next section describes the configuration steps of Produmex SB1 Notification Listener. If you do
not need this component, click Save on the Produmex Suite Installer screen and close the screen.
Continue with section 3.4. Adaptation of Stored Procedures.

 
 

3.3.3. Configure the Produmex SB1 Notification Listener

Note: Make sure you do not perform the configuration on an environment with active users.

https://wiki.produmex.name/doku.php?id=support:supportguidev2:licenseissues#no_fat_client_license_available
https://wiki.produmex.name/doku.php?id=implementation:wms:3plprocess
https://wiki.produmex.name/doku.php?id=implementation:wms:edi_module
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In order to activate the SB1 Notification listener, you need to enable the Service Broker as follows.

1. On the Produmex Suite Installer screen click the Config button of the Produmex SB1 Notification
Listener.

2. Click the Run in console mode button of the Configuration Database option.

It shows the following console.

3. Press ENTER to finish the database configuration.

Now list the actions that the Produmex SB1 Notification Listener needs to listen to by proceeding as
follows.

4. Click the Run in console mode of the List Actions option.

The tool adds the actions to the config-file located in the installation folder of the Produmex SB1
Notification Listener.
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5. Press ENTER to exit and close the screen of the options.

6. Click Save on the Produmex Suite Installer screen and close it.

Continue with section 3.4. Adaptation of stored procedures.

 
 

3.4. Adaptation of stored procedures

3.4.1. Enable the standard PMX stored procedure

The following sections describe the process of enabling the standard PMX stored procedure with
Microsoft SQL (section 3.4.1.1) and SAP HANA (section 3.4.1.2).

3.4.1.1. With Microsoft SQL Server

After the configuration is done, you need to enable the (custom) stored procedures in the stored
procedure of SAP named “SBO_TransactionNotification”.

When applying the Produmex Add-on the first time to a database, you also need to adapt the stored
procedure “SBO_SP_TransactionNotification”.

1. Open SQL Server Management Studio and connect to your database server.

2. Expand the Databases folder and locate the database to which you want to apply the Produmex
Add-on.
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3. Open this database directory and open the “Programmability\Stored Procedures” subdirectory.

4. Locate the “dbo.PMX_SP_TransactionNotification” stored procedure, right-click it and select
“Modify”.

5. Locate the “Produmex Logex Addon Code” at the end of this stored procedure (see illustration
below)

6. Copy the “Produmex Logex Addon Code”.
Now paste the code into the “dbo.SBO_SP_TransactionNotification” stored procedure as follows.

7. Locate the “dbo.SBO_SP_TransactionNotification” stored procedure, right-click it and selectModify.



Last
update:
2021/10/21
11:23

implementation:wms:completeinstallguide https://wiki.produmex.name/doku.php?id=implementation:wms:completeinstallguide

https://wiki.produmex.name/ Printed on 2025/08/09 01:21

8. Paste the “Produmex Logex Addon Code” at the end of it. With a new installation you will see a
marked area like “– ADD YOUR CODE HERE”.

9. Uncomment the SP by clicking on the Uncomment button in SQL Management Studio.
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10. Execute the SBO_SP_TransactionNotification stored procedure.

Continue with section 3.4.2. Enable a custom stored procedure.

3.4.1.2. With SAP HANA

After the configuration is done you need to enable the (custom) stored procedures in the stored
procedure of SAP named “SBO_TRANSACTIONNOTIFICATION”.

When applying the Produmex Add-on the first time to a database you will also need to adapt the
stored procedure “SBO_SP_TRANSACTIONNOTIFICATION”

1. Open the SAP HANA Studio and connect to your SAP HANA server.

2. Expand the “Catalog” folder and locate the schema to which you want to apply the Produmex Add-
on.

3. Right-click on this schema and select “SQL Console” to open a new SQL console.
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Keep this SQL console open during the whole process.

4. Expand the schema directory and open the “Procedures” subdirectory.

5. Locate the “SBO_SP_TRANSACTIONNOTIFICATION” stored procedure, right-click it and select “Open
Definition”.

6. Open its content by opening the Create Statement tab:
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7. Copy the content into the SQL console.

8. Locate the “PMX_SP_TransactionNotification” stored procedure, right-click it and select “Open
Definition”.

9. Open its content by opening the Create Statement tab, and locate the “Produmex Logex Addon
Code” at the end of this stored procedure (see illustration below).

10. Copy the “Produmex Logex Addon Code”.

11. This code should now be pasted into the SQL console, where you have already pasted the content
of the “SBO_SP_TRANSACTIONNOTIFICATION” stored procedure. Paste the “Produmex Logex Addon
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Code” at the end of it. With a new installation you will see a marked area like “– ADD YOUR CODE
HERE”.

12. Uncomment the copied code by removing the leading '–' from each line.

13. Add the following line on the top of your SQL console:
DROP PROCEDURE SBO_SP_TransactionNotification;

The SQL console should look like this:

14. Execute the code in your SQL console to modify the SBO_SP_TRANSACTIONNOTIFICATION
procedure.

 

3.4.2. Enable a custom stored procedure

Every custom stored procedure related to Produmex WMS should be called from the
PMX_TransactionNotification stored procedure as this stored procedure is executed from all Produmex
WMS flows and processes when creating or modifying a document.

The SBO_SP_TransactionNotification is only called when creating or modifying a standard SAP
document.

1. Open the custom stored procedure.

In this example: PMX_SP_OECTransactionNotification.

2. Select the commented text and copy it to the clipboard (Ctrl+C).

3. Open the PMX_SP_TransactionNotification for modification.

4. Paste the text to the PMX_SP_TransactionNotification (Ctrl+V) and uncomment it.
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Note: If you have an older custom stored procedure, the header of the commented text may say that
you should add it to the SBO_SP_TransactionNotification, but it should be added to the
PMX_SP_TransactionNotification in this case as well.

5. Alter the PMX_SP_TransactionNotification with this modification.

Stored procedure call hierarchy

 

3.4.3. Enable the Notification Listener stored procedure

After configuring the SB1 Notification Listener, the stored procedures must be enabled in the
“PMX_TransactionNotification” SAP stored procedure as follows.

Note: If the SB1 Notification Listener is not installed, continue with section 3.5. Register the Produmex
add-on.

With Microsoft SQL Server

1. Open the SQL Server Management Studio and connect to your database server.

2. Expand the Databases folder and locate the company database to which you want to apply the
Produmex Add-on.

3. Open this database directory and open the Programmability / Stored Procedures subdirectory.
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4. Locate the dbo.PMX_SP_TransactionNotificationQueue stored procedure, right-click it and select
Modify.

5. Locate the Produmex SboNotification Queue Code at the end of this stored procedure (see
illustration below).

6. Copy the Produmex SboNotification Queue Code.

This code should now be pasted in the “dbo.PMX_SP_TransactionNotification” stored procedure in the
Company database as follows.

7. Locate the “dbo.PMX_SP_TransactionNotification” stored procedure, right-click it and select
Modify.

8. Paste the “Produmex SboNotification Queue Code” at the end of it, right after the code you have
copied for the Produmex Addon stored procedure (see 3.3.1. Enable the standard PMX stored
procedure).

9. Uncomment the SP by clicking the Uncomment button in SQL Management Studio.
The result should look like this:

10. Execute the PMX_SP_TransactionNotification stored procedure.

With SAP HANA

1. Open the SAP HANA Studio and connect to your SAP HANA server.

2. Locate the PMX_SP_TransactionNotificationQueue stored procedure, right-click it and select Open
Definition.

3. Open its content by opening the Create Statement tab.

4. Locate and copy the Produmex SboNotification Queue Code at the end of this stored procedure.
This code should now be pasted in the PMX_SP_TransactionNotification stored procedure.
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5. Locate the PMX_SP_TransactionNotification stored procedure, right-click it and select Open
Definition.

6. Open its content by opening the Create Statement tab.

7. Paste the Produmex SboNotification Queue Code at the end of it.

8. Uncomment the copied code by removing the leading '–' from each line.

9. Execute the code.

 
 

3.5. Register the Produmex add-on

The following section describes the steps of registering the Produmex add-on component in SAP
Business One on premise (section 3.5.1) or on the Cloud Control Center (section 3.5.2).

Note: Make sure that you run the SAP Business One Client as administrator.

3.5.1. Register the add-on on premise

1. In SAP Business One navigate to Administration > Add-Ons > Add-On Administration.

2. Click the Register Add-On button.

3. Click the … button and browse the add-on loader installation .ard file.

The installation file is located in the installation zip folder \<SBO Version>\AddOnLoader.
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When selecting the file, the associated add-on installation package is also opened.

4. Check the Install as Part of Registration checkbox and click OK.

5. On the Add-on Installer screen select the installation folder, then click Next and then Finish.

6. When the installation is finished, restart SAP Business One.

7. In SAP Business One navigate to Administration > Add-Ons > Add-On Administration.
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8. On the Company Preferences tab select the Produmex Add-On Loader. Select the Active checkbox
and set the Default Group.

From 2020, Produmex WMS version number contains 15 characters. In the Version column of the Add-
on Administration window, SAP Business One 9.3 displays the first 13 characters of the installed add-
on version.

The version number of the installed add-on loader can be found in the Add-On Name column.

9. On the User Preferences tab select the user manager and make sure that the Preferences is set to
the required value for the Produmex Add-on Loader.

10. Click Update.

Continue with section 3.5.3. Update database.

3.5.2. Register the add-on on the Cloud Control Center

3.5.2.1. Install the Add-On Loader on the Cloud Control Center

1. Create a Produmex subfolder within the folder you defined as the Extension Repository Path in
Cloud Control Center.

2. Upload the zip folder of the lightweight installer to this Produmex folder. Do not unzip the file.

The zip folder is named:
Produmex_WMS_<versionnumber>.<SBOversion>_AddOnLoader_lightweight.zip.
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It can be found in the installation zip folder of Produmex WMS:
Produmex_WMS_<versionnumber>.<SBOversion>\<SBOversion>\AddOnLoader.

Regardless of the environment displayed in the name of the Produmex WMS installation
folder, the lightweight installer zip contains both the x32 bit and the x64 bit installation
files.

3. On the Cloud Control Center, navigate to Landscape Management > Extensions.

4. Check whether the installation file is listed on the Extensions grid.

5. Click the Synchronize All button to install the Produmex Add-On Loader and confirm that you
would like to synchronize all extensions by clicking Yes.

If the installation is successful, the status of the Produmex Add-On Loader is successful on the
Synchronization Report screen. The installation zip is automatically moved to the Produmex Shared
Repository folder.

3.5.2.2. Deploy the Add-On Loader to the Service Unit

When upgrading the add-on to a new version, make sure that the add-on is not running
on any presentation server. If there is a running add-on, the upgrade will fail.

The next step is to deploy the add-on loader on every service unit where you would like to use it.

1. Navigate to Landscape Management > Service Units.

2. Select the target service unit on the Service Units grid.

3. To to the Extensions tab on the Service Unit Details grid and click the Deploy button.

4. Follow the steps of the Extension Deployment Wizard.

5. Select the Produmex Add-On Loader at the Select Extensions step, then finish the deployment.

3.5.2.3. Assign the add-on loader to the tenant(s)
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The next step is to assign the Produmex Add-On Loader to the tenant(s) where you would like to use
it.

Note: This step is not required for a version upgrade.

1. Go to Customer Management > Tenants.

2. Select the tenant on the Tenants grid.

3. Navigate to the Extensions tab on the Tenant Details grid and click the Assign button.

4. Follow the steps of the Extension Assignment Wizard.

5. Select the Produmex Add-On Loader In the Select Extensions step, then finish the assignment.

3.5.3. Update database

Note: This step is not required for a version upgrade.

1. In SAP Business One navigate to Administration > Add-Ons > Add-On Manager > Installed Add-Ons
tab.

2. If the Produmex Add-On Loader is not running, select it and click Start. The Produmex WMS add-
on is started.

 

3.6. Configure clients

1. In SAP Business One navigate to Produmex > Organizational Structure.

2. Click on your company name.
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3. Make sure the IP address or host name of the server where the PMX License Server is running is
filled in as add-on clients require this to be able to connect.

You can do this initially on the SBO license server itself because the add-on will try to connect locally
if this field is empty.

If it is not possible to run the add-on on the machine running the PMX License Server, enter this
information in the database after creating the company element. Table “PMX_OSCO”, field
“SboLicenseServerAddress”: only enter the IP address or host name, no port or other information is
allowed.

The process of a fresh installation is finished. The next section describes the process of performing a
version upgrade.

 
 

4. Performing a Version Upgrade

This section describes the process of performing a version upgrade. As installing a new version of
Produmex WMS over an older version is similar to a fresh installation, this section does not go into
detail in the parts that are the same as in a fresh installation.

https://wiki.produmex.name/lib/exe/detail.php?id=implementation%3Awms%3Acompleteinstallguide&media=implementation:wms:functional:general_tab.png
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In case of an SAP B1 patch level upgrade, only the configuration
of Produmex Tools is necessary to be performed. See section
4.3.1. Configure the Produmex Tools.

Upgrading to product version 19.2 or higher from a version lower than 19.2 removes the
need for an extra PMX database. For performance reasons all standard views, functions
and stored procedures are created in the company database. Any customized view,
function and stored procedure needs to be moved manually.

The existing extra PMX database is not removed by this upgrade. The database still
exists and can be used for moving the necessary views, functions and stored procedures
manually.

Upgrading to product version 19.2 or higher from a version lower than 19.2 is a non-
reversible operation and future product versions will have this migration as well,
therefore, it is recommended to create backups.

For upgrading from a pre-19.2 product version to any later one, version 19.2 needs to be
installed first.

4.1. Uninstall components

Make sure that no one (neither SAP users nor Device clients) is logged in the SAP live
environment by checking the Task Manager and disconnecting each user with open
connection to the server. Make sure that no DB sessions are connecting to the company
database on the SQL server.

Note: Device clients, like touchscreen-terminals and scanners, keep most of their data in cache, such
as company settings and installation files. When these devices boot, they connect to the server and
retrieve the new scripts and other installation files.

1.(Optional) Copy the configuration file ProdumexInstallConfig.xml from your previous installation
folder into the ProdumexSuiteInstaller directory of your new version (It can be found in the installer
package in the following sub folder: \10.0\ProdumexSuiteInstaller). This way you do not have to
specify your SAP Business One databases manually.

2. Start the Produmex Suite Installer as an administrator. (It can be found in the installer package in
the following sub folder: \10.0\ProdumexSuiteInstaller)

3. Accept the End User License Agreement.

4. Click Uninstall All to uninstall each installed component.
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5. (Optional) Remove the outdated script assemblies, especially when newer versions of standard
scripts or customizations within project files are involved. Deleting old script assemblies ensures
integration of the latest updates, preventing conflicts and maintaining system stability. For removing
obsolete scripts, delete the c:\Produmex\ScriptAssemblies folder.

4.2. Install components

From product version 2021.03, Produmex WMS requires License Server version 2021.03
or higher and does not work with previous License Server versions. Upgrading the
License Server to version 2021.03 is a one-time operation, that is, future add-on versions
are expected to work with License Server 2021.03.

Install all the necessary components. The installation process is the same as for a fresh installation
(see 3.2. Install components).

 

4.3. Configure components

4.3.1. Configure the Produmex Tools

1. Click on the Config button of Produmex Tools.

2. Select an instance alias which will connect to a company database that will be updated to the
required Produmex version.

3. Click the Run button to start the Produmex Database Upgrade tool.

4. Change the default settings on the Produmex Database Upgrade screen if necessary and click
Start (for information on the settings see section 3.3.1. Configure the Produmex Tools).

5. If you are upgrading to version 19.2 or higher from a version lower than 19.2, a pop-up window
informs you that the upgrade removes the need for an extra PMX database. Consult with the
description on the pop-up window and click OK to proceed.

6. Confirm that you accept the creation of extra database items in the company database by entering
CONFIRM in the field. This confirmation step is needed to ensure that you understand and take note of
the change.
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Note: The field is case sensitive. If you enter the wrong data, the installation process stops. In this
case you need to close the Produmex Database Upgrade screen and start the configuration again.

7. The Produmex Database Upgrade displays the process.
The tool looks for the installed version, adds the necessary database modifications and you will also
see custom adjustments executed if applicable.

8. On the Add-on Uploader Form select all row(s) corresponding to the installation and click Upload or
if all the rows must be selected, click Select All and then click Upload.

When the upload is finished, click OK on the form and the screen is automatically closed.

9. When the upload is complete, close the Add-On Uploader Form and the Database Upgrade screen.

10. After starting the AddOn Loader in the SAP client, it will download the new files to the local
computer into folder: “c:\Program Files\SAP\SAP Business One\AddOns\PMX\Produmex Add-On Loader
20\” Start the SAP client in Run as Administrator mode at first time after the upgrade.

4.3.2. Configure the Produmex License Server

Configure the Produmex License Server in the same way as for a fresh installation (see section 3.3.2.
Configure the Produmex License Server).

The next section describes the configuration of the SB1 Notification Listener. If you do not need the
tool, click Save on the Produmex Suite Installer screen and close it. Continue with section 4.4.
Adaptation of stored procedures below.
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4.3.3. Configure the SB1 Notification Listener

1. On the Produmex Suite Installer screen click the Config button of the component.

2. Run the Configure database option in Console mode and when this is complete, press Enter.

3. Run the List Actions option in console mode and when this is complete, press Enter.

The configuration process is finished. Click Save on the Produmex Suite Installer screen and close the
window.

4.4. Adaptation of stored procedures

Adjust the standard SBO_SP_TransactionNotification with the T-SQL code from the
PMX_SP_TransactionNotification stored procedure in the same way as for a fresh installation (see
section 3.4. Adaptation of stored procedures).

Note: The same procedure applies to any custom stored procedure (if included in the custom version).

 

4.5. Register a new add-on loader

Start SAP Business One and the add-on files are automatically loaded.

In general, for a Produmex WMS version upgrade it is not required to install a new version of the add-
on loader. Consult with the Compatibility Matrix and check if the installation of a new version is
needed. The document describes which add-on loader version is required for the given add-on
version.

Note: It is possible to have multiple add-on loader versions installed on one server.

(For more information on how to install the Add-on Loader see section 3.5. Register the Produmex
add-on.)

The process of performing a version upgrade is finished. Make sure that the company settings of your
organizational structure are correct.

The next section describes the process of adding a new database to an existing installation.

 
 
 

5. Adding a New Database to an Existing Installation

This section describes the steps of adding a new database to an existing installation.

https://wiki.produmex.name/doku.php?id=implementation:general:compatibility_matrix
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1. Start the Produmex Suite Installer and go to the General tab.

2. Click on the green + button and set the connection details (see section 3.1.1. General tab).

3. Test the SBO and the direct connection by clicking on the …test… buttons.

4. Go to the tab of the server you want to connect the database to.

5. Click the Update Connection String button.

The connection strings assigned to the selected environment are added to every configuration file
that belongs to that environment.

Note:

Passwords provided in the connection string is encrypted.
Already added connection strings are not removed from the configuration files.

6. Click on the Config button of the Produmex Tools and run the Produmex Database Upgrade tool
on the new database (see section 3.3.1. Configuring the Produmex Tools).

7. Adjust stored procedures (see section 3.4. Adaptation of stored procedures).

8. Check if the references between the company database/schema and the Produmex
database/schema are set correctly and are pointing to the right database.

Check the following stored procedures:

SBO_SP_TransactionNotification/SBO_SP_TRANSACTIONNOTIFICATION
PMX_SP_TransactionNotification/PMX_SP_TRANSACTIONNOTIFICATION
additional stored procedures if the customization requires their modification

If you are using SAP HANA, also check the references in the following stored procedures:

PMX_SP_TRANSACTIONNOTIFICATIONCHECKS
PMX_SP_TRANSACTIONNOTIFICATIONSTOCK

9. Check if the Add-On Loader is assigned to the new company database.

 

6. Creating a Test Environment

6.1. Backup and restore
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1. Create a backup from the company database/schema.

2. Restore the test database/schema with the backup created from the live database/schema and the
test PMX database/schema with the backup created from the PMX live database/schema.

When restoring a database in MSSQL, make sure that you change the database/schema file
names on the Files page as well.
For more information about schema export, import and migration on HANA click here.

If you backup and restore the company database/schema only, customizations added in
the PMX stored procedures will not be copied to the test environment.

6.2. Upgrade database

1. Start the Produmex Suite Installer.

2. Click the green + icon to add a new connection.

3. Set the environment to Test.

4. Specify the connection string in the Alias column.

5. Add the name of the company database.

6. Enter the SAP user name and password.

7. Test the SBO connection and the Direct connection.

8. Go to the tab of the database/schema server and change the Target environment to Test.

Components are installed in separate subfolders marked as Test when executing the installation in
the Test environment.

9. Adjust the Directory path if needed.

10. Click the Assign to this computer button to mark that this is the server you are currently
working on.

11. Install Produmex components and run the database/schema upgrade. Make sure that you select
the right connection string.

Note: You cannot install a test Produmex License server. Before clicking the Install all button,
make sure that you disable the Produmex License Server.

https://wiki.produmex.name/doku.php?id=implementation:howtos:migrate_hana_schema
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If there is an installed PMX version in the test environment and you don’t need an upgrade, you can
adjust the connection string in the configuration files by clicking the Update connection string
button. For more information click here.

6.3. Adjust company settings

1. Run the Produmex add-on and open the Organizational Structure. On the General tab adjust the
following if needed:

username
password
license server

2. On the Config tab adjust the EDI folder paths to make sure that test documents are not mixed with
documents created for the live database/schema. The following paths needs to be adjusted:

Interface monitor input archive path
Interface monitor input error path
Interface monitor input path
Interface monitor output archive path
Interface monitor output error path
Interface monitor output path

 
 

Setting Up Mobile Devices

Windows CE

1. Setup the Wi-Fi connection

Press the ‘Connections’ button → Select the ‘Find WLANs’ option → Select a network and press it →
Press ‘Connect’.

Adjust the profile settings in the ‘Profile Entry’ window. After pressing on the ‘Finish’ button, the
profile will be active.

It is recommended to set the IP address to Manual Fixed IP instead of DHCP. Make sure that the
suggested IP address is not in use. Another solution would be to leave the PDA in DHCP, and set the
Fixed IP as a setting in the router’s DHCP lease table.

To set the correct country open the ‘Options’ window. Select the ‘Regulatory’ option then select the

https://wiki.produmex.name/doku.php?id=implementation:wms:config
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country. Make sure that the ‘Enable 802.11d’ option is not checked.

Save the ‘Profiles and Options’ to the fixed memory of the scanner. In the ‘Options’ window select
‘Export’ from the dropdown menu. Press the ‘Export All Profiles’ button then press ‘Save’.

2. Setup Remote Desktop Connection

Open the ‘Remote Desktop Connection’ window. In the ‘General’ tab, fill in the ‘User name’ and
‘Password’ fields.
In the ‘Loc Res.’ tab, select the keyboard setting ‘On the local computer’ from the dropdown menu.
In the ‘Exp.’ tab, disable ‘Themes’.
Then go back to the ‘General’ tab and save the settings to the fixed memory.

How to set up auto start
We recommend to set up the automatic start of Produmex WMS for the Windows RDP user.
Open Computer Management and navigate to the Users folder via: System Tools > Local Users
and Groups. Select the device form the list and choose the Properties option from the right-click
menu.
On the opening Properties screen go to the Environment tab. On the Starting program section
enable the ‘Start the following program at logon’ checkbox and add the file with its path to the
‘Program file name’ field.
When configuring auto start this way, the RDP session is automatically logged of after the
Produmex WMS application is closed.

Please note: The exact steps might differ from the steps described, depending on operation
system used.

3. Setup config for standard DataWedge to send AIM ID’s

1. Press the DataWedge icon
2. Select 'Advanced Configuration'
3. Select 'Profiles'
4. Select 'Profile0'
5. Select 'Input'
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6. Select 'Scanner'
7. Select the scanner type
8. Select 'Scan params'
9. Select 'CodeID'

10. Set to 'Aim'. Press '0.Back' to go out of this screen.
11. Come back to this screen and check whether the CodeID is set to Aim. If yes, select 'Home'.
12. Select 'Exit'.
13. Click 'OK' to confirm exit.

4. Setup for power usage (Recommended)

4.1. Automatic sleep mode

Go to control panel → Power → Advanced tab → 'On Battery power' setting

To set an interval, choose an interval (mx 5 min) from the dropdown list.

To turn off the automatic sleep mode, uncheck the box. The device will never go into sleep mode.
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4.2. Backlight

It is possible to set up so that the back light is cut after a certain amount of time or not at all. You can
choose this yourself, depending on the intensity of your battery usage. We recommend to set the
backlight with a timeout, because this is the main battery consumer.

5.Change Intercharacter delay setting

When the gun is sending chars too quickly through the RDP, it might cause incorrect character display
on the scanner.

To avoid this issue, setup interchar delay on DataWedge. Go to the ‘Advanced Configuration’ menu.

Follow these steps: Profiles > Profile0 > Output > KeyStroke > InterCharacter Delay
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Specify “10” into the text box, and press Save. Go back until you come back to the main screen and
then 0.Exit.

6. How to access the memory slider bar

Select Start > Settings > Control Panel.1.
On the Control Panel scroll down until you see the 'System' icon. Double click on the icon. The2.
System Properties screen will open.
Go to the 'Memory' tab. A slider bar will show on the screen with the following verbiage: Move3.
the slider to the left for more memory to run programs. Move it to the right for more storage
space. Only unused RAM (dark portion of the slider bar) can be adjusted.

 



Last
update:
2021/10/21
11:23

implementation:wms:completeinstallguide https://wiki.produmex.name/doku.php?id=implementation:wms:completeinstallguide

https://wiki.produmex.name/ Printed on 2025/08/09 01:21

7. Screenshot tool for Windows CE

Before connecting the device, make sure you have an USB dongle for the connection. Also make sure
that the Windows Mobile Device Center is installed on your PC. If not, download it from the following
link: http://www.microsoft.com/en-US/download/details.aspx?id=14

After connecting the device to the PC, the Windows Mobile Device Center will start automatically.
Select the ‘Connect without setting up your device’. On the next screen, select ‘Browse the contents
of your device’ from ‘File Management’. The menu of the device will open in a new window.

Download the screenshot tool from the Produmex FTP:
ftp://public:Avaya789@ftp.produmex.name/Hardware/ScreenshotTool/ScreenshotTool.zip
Extract the .zip file. Copy the terminal.exe and paste it onto the device through the Windows Mobile
Device Center. It is recommended to paste it into the ‘My Documents’ folder.

On your PC, execute the PC.exe file from the Screenshot Tool folder. This will open a window where
the scanner screen will be displayed after the connection setup.

On the device, execute the terminal.exe. Press ‘Ok’ on the ‘About CERDisp’ window. On the ‘Remote
Display Control’ window, press ‘Connect’. ON the next window add the hostname to the ‘Hostname’
field then press ‘Ok’.

Now the screenshot tool is running on your PC and the device can be accessed through the previously
opened window.

 

Android

1. Setup Wi-Fi connection

Set up the Wi-Fi connection on the device from Android settings.

2. Setup Remote Desktop Connection

Install Remote Desktop on your device. If the device has access to Google Play, install the Microsoft
Remote Desktop app from Google Play, otherwise download the Microsoft Remote Desktop .apk file
and install it manually on the device.

Open the Remote Desktop app and set up your connection.

Press the ‘+’ icon and select ’Desktop’ to add a new connection. Press ’ADD MANUALLY’.

http://www.microsoft.com/en-US/download/details.aspx?id=14
https://wiki.produmex.name/lib/exe/detail.php?id=implementation%3Awms%3Acompleteinstallguide&media=implementation:install:scanner:wmdc.png
ftp://public:Avaya789@ftp.produmex.name/Hardware/ScreenshotTool/ScreenshotTool.zip
https://wiki.produmex.name/lib/exe/detail.php?id=implementation%3Awms%3Acompleteinstallguide&media=implementation:install:scanner:menu_sst.png
https://wiki.produmex.name/lib/exe/detail.php?id=implementation%3Awms%3Acompleteinstallguide&media=implementation:install:scanner:termial.png
https://wiki.produmex.name/lib/exe/detail.php?id=implementation%3Awms%3Acompleteinstallguide&media=implementation:install:scanner:device_screenshottool.png
https://wiki.produmex.name/lib/exe/detail.php?id=implementation%3Awms%3Acompleteinstallguide&media=implementation:install:scanner:device_screenshottool.png
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Enter the IP address or the host name as the PC name. Add the user account by entering the user
name and password.

Press ’Show additional options’ and select ’Customize display resolution’ from the expanded menu.

The handheld fat client is designed to work on a 240×320 resolution. If the resolution of the device is
greater than 240×320, custom display settings are needed.

Press ’Show additional options’ and select ’Customize display resolution’ from the expanded menu.

Enable the custom display resolution and add a custom resolution and scaling. The optimal resolution
and scaling depends on the device. Finding the optimal resolution and scaling might require some
trial and error.

Please note: Scaling is available beginning from Windows 8.1 and Windows Server 2012 R2.

Go back to the Add desktop menu and press ‘SAVE’ to save your configurations.

Open remote desktop and press the  icon. Set the mouse mode to ’Touch’. Press the ‘Touch’ icon on
the right sidebar. The mouse mode is ‘Touch’ if the ‘Mouse Pointer’ icon is displayed.

2.1. Display settings

We recommend to set the orientation as ‘Portrait’. This can be done in the following ways:

2.1.1. Remote desktop

Set the orientation of the Remote Desktop app to Portrait. Open the app settings and select the
‘Display’ menu. Set the Orientation to ‘Lock to portrait’.

2.2.2. Device

Set the orientation of the device to Portrait or disable Auto-Rotate on the device.

3. Configure automatic start

https://wiki.produmex.name/lib/exe/detail.php?id=implementation%3Awms%3Acompleteinstallguide&media=implementation:wms:android:icon.png
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We recommend to configure Produmex WMS to start automatically on connection. This can be done in
the following ways:

3.1. Startup folder shortcut

Create a shortcut in the Startup folder. Please note: The location of the Startup folder depends on the
operating system version. On the ‘Shortcut’ tab of Properties add the access path and the startup
configurations of the fat client to the Target field.

3.2. Batch file

Create a batch file containing the access path and the startup configurations of the fat client.

Example:

"C:\Program Files (x86)\Produmex\Produmex Fat
Client\Produmex.Sbo.Logex.Execute.FatClient.exe" /f+ /s- /w:240 /h:320
/a:Produmex.Foundation.SlimScreen.WinGui.PocketSize /i:SCAN_2

https://wiki.produmex.name/doku.php?id=implementation:wms:fatclientconfig
https://wiki.produmex.name/doku.php?id=implementation:wms:fatclientconfig
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Create a scheduled task for the batch file that is triggered at log on.

4. Scanning configurations

On most systems scanning settings are assigned to profiles. By default the settings of the default
profile are applied, but it is possible to create specific profiles for applications. Profile handling may
differ based on the device.

Set the following scanning configurations for the profile you would like to use:

Set the code type to AIM ID.1.
Set to send ENTER after the barcode data2.

Configuration steps may differ based on the device and the Android version. This documentation
includes the configuration steps for the following:

Honeywell Dolphin 75e – Android 6.0.1.
Zebra MC9200 – Android 4.4.4.
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4.1. Example 1: Honeywell Dolphin 75e – Android 6.0.1

Open Android Settings. From the Honeywell settings select ‘Scanning’.

Press ‘Internal Scanner’ and select the profile you would like to use from the list of profiles.

Press ‘Data Processing Settings’. In the Data Processing Settings menu set the Symbology Prefix to
‘AIM’. To send the ENTER key after the barcode data, add ‘\r’ as the Suffix.

4.2. Example 2: Zebra MC9200 - Android 4.4.4

Open the DataWedge app. Select the profile you would like to use from the list of profiles.

From the BARCODE INPUT plugin select ‘Scan params’. Press ‘Code Id Type’ and set the code ID type
to AIM.

From the KEYSTROKE OUTPUT plugin open ‘Basic data formatting’ and enable the ‘Send ENTER key’
setting.
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5. Setup for power usage

We recommend to adjust the following settings in order to save on power usage:

5.1. Sleep mode

Adjust the sleep mode settings.

5.2. Backlight

Adjust the backlight settings. The configuration steps depend on the device.
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